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1 About this document 

1.1 Other Applicable Documents 

The information for the AG4 Safety Laser Scanner is covered within multiple documents. The documents and software for configuring the AG4 are 
contained on the CD that comes with the product. 

Table 1 AG4 Documents & Software 

Document/software title  Document topic  Source  

User Reference Guide  
General product information and diagnostic 
reference tables 

Part no. 145034.  
Included with the product as print and on CD-ROM  

AG4soft program  AG4 configuration and diagnostic software  Included with the product on CD-ROM 

AG4 Product Manual  
AG4 operation capabilities, functions, 
applications, for the machine designer  
Includes checkout procedures 

Part no. 144924  
Included with the product on CD-ROM  

AG4soft Software Manual  
(this document)  

AG4 software instructions:  
How to: Configure operational settings,   
             Access diagnostic information  
             Manage configuration files 

Part no. 144923  
Included with the product on CD-ROM  

 

The current software version and all PDF documents can be downloaded from the Banner website http://www.bannerengineering.com.  
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2 System requirements 

2.1 Computer 

A PC with the following specifications is required to use the software: 

Processor type Intel® Pentium or comparable, e.g. AMD® or Cyrix® 

Operating system Microsoft® Windows 95/98/NT®/2000/XP® 

RAM At least 64 MB 

Hard disk memory At least 50 MB free memory 
You require more memory space if you want to save protective field 
or configuration values. 

Screen display Color 

External drive CD drive 

Input device Keyboard and mouse or touchpad 

Output device Printer (black and white or color) 

Serial interface RS232 or RS422  
Use an appropriate adapter if the PC has a USB interface instead of 
a serial interface. 

 

6 144923 05/2009 Software Manual 

 



Banner AG4soft Software Instruction Manual  
 

3 AG4soft Overview 
The AG4soft program is used to both establish operational settings for the Scanner and to display measurement and system information produced by the 
scanner. Communication between the PC and the AG4 is via an RS232 interface, either RS232-to-RS232 or USB-to-RS232.  

 

 

Use this software only for Banner Scanner model AG4-4E.  

 

3.1 Configuration 

The AG4 Scanner is preprogrammed at the factory with a default configuration but must be reconfigured for each application. The factory default 
configuration is stored as a file (standard.rs) in the AG4soft program directory during the software installation on the PC: 

 
C:\Program Files\Banner Engineering\Banner AG\AG4soft\examples 

3.1.1 Configuring the AG4 

The configuration settings are created by a trained and Qualified Person who understands the AG4 instruction materials. These settings are saved in a 

configuration file which has the *.rs file format and includes all the information that the AG4 requires for its intended operation. An AG4's configuration file 
includes the following data: 
 Administrative data, e.g. file name, application description  
 Safety-relevant data, e.g. startup process  
 Protective Field or warning field configuration data, e.g. contours and limits 

A wizard in the program assists users with the AG4 configuration process. 

3.1.2 Protective and Warning Fields 

The software makes it easy to establish protective and warning fields. The protective field and the warning field are user defined areas that the Scanner 
monitors. An intrusion into the protective field (e.g. a person walking into a monitored work cell) will cause the Scanner to turn its safety outputs off. An 
intrusion into the warning field will cause the Scanner to create a warning signal.  

Protective field and warning field settings are created and saved as field pairs. Up to 8 configurable field pairs are available for the AG4. A field 

configuration file has the *.sf file format and includes data on the size of each protective and warning field. Field pairs can be enabled or disabled, one 
field pair at a time, while the Scanner is operational and actively monitoring a work area. This function is useful when changing machine guarding 
requirements create the need for changes in protective and warning field dimensions. 
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3.2 The Monitored Space Display 

When a Scanner is actively monitoring an area, it measures the distance to, and the angular position of, objects in the area. These measurement data are 
transferred via the RS232 connection from the AG4 to the PC. The AG4soft program uses this data to constantly update the display to show the protective 
and warning fields along with the measured surfaces of the monitored area (see Figure 1 below). 

 

  
 

Figure 1 Display of monitored area along with the rectangular protective (red) and warning (green) fields 
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4 AG4soft Interface 

4.1 Interface Layout 

In addition to displaying a graphic rendering of the monitored area, the software provides configuration and file management tools, including file title 
header, drop-down menu bar, and function-specific worksheets which contains buttons relevant to the specific function. The menu bar and worksheets are 
used to create or edit the AG4’s operational and application settings (see interface and function key below). 

 
Drop Down 

Menus
Worksheet Tabs

File Name Header

Monitored Area
(workspace)

Worksheet Tool Bar

Navigation Area

Status 
Information

Field Information

 

 

Position Name Description 

1 File name header Identifies the configuration file that is being used 

2 Drop-down menu bar 
Includes functions for; software display & communication settings, AG4 configuration settings, file management 
operations, system data access and fault diagnostics.  

3 
Function-specific 
Worksheets 

These worksheet tabs provide access to the tool set and display that is appropriate for the specific configuration 
function or file operation being performed.. 

4 Monitored Area Display Graphically displays the monitored area and protective/warning field boundaries (contours). 

5 Navigation area 
Displays both XY & Polar coordinates of the cursor position and contains an 5 button interface for changing the view 
of the monitored area. 

6 Field Information area Identifies the number of active field pairs and the source of the configuration data 

7 Status Information area Displays: AG4 - PC connection, data exchange, current active worksheet, field status and login authority information 

Figure 2  AG4soft Interface 
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4.2 File Name Header 

The file name header (refer to Figure 2) identifies which configuration file is active in the AG4soft program. This file can be retrieved from the AG4soft 
system folder or can be pulled in from an AG4 scanner. 

4.3 Drop-Down Menu Bar 

The Drop-Down Menu Bar provides access to the following functional areas: 

 File -- load and save both configuration and protective/warning field files 

 View -- change the field of view or save a copy of the monitored area being displayed 

 Settings -- access worksheet functions or change PC and worksheet display settings 

 Configuration -- configuration file edit and transfer operations 

 Protective/warning Field -- field parameter file edit and transfer operations 

 System data -- data used for fault diagnostics and maintenance purpose 

 Security -- password change options 

 Help --  instruction manual and reference material access 

4.4 Function- Specific Worksheets 

Each worksheet has a specific set of tools and a monitored area or worksheet display that is helpful when using the tools. The worksheets provide access 
to the following functions: 

 Measured contour display -- a “real time” display of the surfaces and protective/warning fields in the monitored area. 

 Configuration -- configuration file edit and transfer operations 

 Protective/warning fields definition -- field parameter file edit and transfer operations 

 System data -- data used for fault diagnostics and maintenance purpose 

Each worksheet includes a set of functions that are enabled according to the user authorization level. 

 

 

Each Function-specific worksheet corresponds to a specific set of functions needed to create or 
edit AG4 configurations.  
NOTE: The selected authorization level determines which worksheet functions are available.  

4.5 Measured Contour (Surface) Display 

The Measured contour display is used to display the location of the measured surfaces and objects as well as the protective and warning fields. The 
software uses the following colors to differentiate the surfaces and field boundaries: 

Table 2.  Contour colors 

Contour Color 

Minimum protective field  Gray 

Protective field  Red 

Warning field Green 

Deactivated protective field  Bright gray 

Deactivated warning field Dark gray 

Measured surfaces Yellow/red 
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Figure 3 Monitored Area Display (workspace) 

 NOTE: The dark blue circle visible in the detection shadow of the object in Figure 3 above, is a movable marker (cursor). This mouse-controlled cursor is 
used when changing the boundaries of the protective and warning fields. 

4.6 Navigation area 

In the navigation area, both XY and polar coordinates of the cursor position are displayed. When using your computer mouse to locate a point in the 
monitored area you can move your mouse pointer to a new point on the monitored area and click the left mouse button and see the new cursor position 
coordinates. This feature is useful when creating protective and warning fields. 

The arrow buttons are arranged in an Up, Down, Left, Right manner and allow the image to be moved within the display. Clicking on the middle button 
optimally scales the frame and refreshes the display to include the entire monitored area.  

4.7 Status Information area 

In the on-screen Status line at the bottom of the screen, five fields are detailed as follows: 

 Communication between PC and AG4 

 AG4 status 

 Operating mode of the software 

 Active protective/warning field status 

 Logged on user's authorization level 
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Table 3.  Status Information Area available data 

Display Status 

AG4 - PC Communication 

AG4 synchronous PC synchronizes the connection between the PC and the AG4 

AG4 connection Data transfer between PC and AG4 is possible 

AG4 Status 

AG4 -> Measurement mode Software receives measurement data from the AG4 

AG4 -> Configuration Software transfers configuration data to the AG4 (OSSDs are OFF) 

AG4 -> Error Error in the AG4 (OSSDs are OFF) 

AG4soft Operating mode (identifies the active Worksheet) 

PC -> Measured value display Measured contour (monitored surfaces) display tools are active 

PC -> AG4 configuration Configuration tools are active 

PC -> Protective/warning field 
definition 

Protective/warning field tools are active 

PC -> AG4 system data System data tools are active 

Protective/warning field 

PF, WF red  Protective and Warning fields interrupted (OSSDs are OFF) 

WF green Warning field interrupted 

Empty  Protective and Warning fields clear 

Logged-on authorization level 

Operator (Op) User is logged in with the Operator (Op) authorization level 

Maintainer (Ma) User is logged in with the Maintainer (Ma) authorization level 

Authorized Customer (AC) User is logged in with the Authorized Customer (AC) authorization level 

Production (Pr) User is logged in with the Production (Pr) authorization level 

Development (De) User is logged in with the Development (De) authorization level 
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5 Configuring the Scanner (Setting Operational Parameters) 

5.1 Configuration Requirements 

Configuring the AG4 requires: 

• Connecting PC to AG4 (via RS232) 

• Starting software and logging in as user 

• Creating or editing an AG4 configuration with the wizard 

• Creating protective field and/or warning field settings 

• Downloading the configuration to the AG4 

• Checking echo data (confirming the AG4 settings) 

5.2 Installing software 

 NOTE: The AG4 is not required for installing the software on the PC. 

Requirements: 

• If the PC and AG4 are already connected with one another, turn the AG4 power OFF. 

• Close all other Windows applications. 

1. Insert the CD ROM. 

 The installation boots up automatically. 

2. Open the Disk1 folder and double-click on the setup.exe file.  

 If the installation does not start automatically from the CD drive, open the folder \AG4soft\Disk1 and double-click the setup.exe file. 

The installation wizard starts. 

3. Click on [Next].  

The installation wizard opens the software license agreement. 

4. To agree with the software license contract, click Yes.  

5. To agree with the recommended installation path, click Next. 
or, 

6. To enter another path, Click on Browse.  

7. Select another path and click on OK , then Next.  

The wizard installs the software and creates a link on the desktop. 

5.3 User Authorization 

The following section describes the AG4soft program function access for each authorization level and the login process. 

5.3.1 Authorization Level 

The Authorization level login permits access to program functions on a need-to-use basis. In other words, the functions that are available depend on the 
selected authorization level. Functions (buttons) that are not actionable in the software program appear as grayed-out versions of the original button. 

No individual user names are required for the login, but an authorization level must be selected.  

The functions for each authorization levels are listed below: 
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Table 4.  Authorization levels and available functions 

Authorization level Functions 

Operator (Op) • Adjust display 
• Display and analyze measured contour 
• Load configuration data from the AG4 
• Load status information from the AG4 
• Display diagnostics list 
• Create service file 
• Reset password 

Maintainer (Ma) In addition to the Operator (Op) functions:  
• Load configuration data from file  
• Load configuration data from file and transfer to the AG4 
• Transfer configuration data from the PC to the AG4 
• Print configuration data 
• Print protective/warning field 

Authorized Customer (AC) In addition to the Maintainer (Ma) functions, full access to all user-relevant functions and parameters:  
• Save configuration data as a file 
• Change all configuration parameters 
• Reset AG4 to default values  
• Define and change protective/warning fields 
• Set reference contour in the protective field  
• Print and delete protective/warning fields 
• Load protective/warning field data from file 
• Save protective/warning field data 
• Transfer protective/warning field data from the PC to the AG4 
• Calibrate the front screen 
• Change passwords 

Production (Pr) Manufacturer-specific access 

Development (De) Manufacturer-specific access 

 

All authorization levels except Operator (Op) are protected with a password. Use the default password when you log in with the AG4 connected to the PC 

for the first time, then change it immediately to a specific Scanner password. The following types of password are used:  

• Default password: Valid for the software and cannot be changed (BannerA or BannerM, depending on whether the user is an authorized 
customer or a maintainer).  

• Specific password: Valid for a specific AG4 scanner. The software saves a user-defined specific Scanner password for each connected AG4, 
which ensures that only authorized users can change the existing configuration. 

The login situation determines which password must be entered in the software, as listed below. 
 

Table 5.  Login situations and password types 

Login situation Password type 

Using only the AG4soft program, without a connected AG4 
Using the AG4soft program with a new AG4 (default settings) connected to the PC 

Default password 

Using the AG4soft program with a user-configured AG4 connected to the PC 
(that has had its default password changed to a specific password) 

Specific password 
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5.3.2 Login 

The AG4soft program can be used without an AG4 connected to the PC, but the functionality of the software is limited. The login procedure depends on 

whether the PC is connected to an AG4. (In addition to the procedures listed below, you may also use the Programs > Banner Engineering > AG4soft  
drop-down menus.) 

Login procedure when the AG4 is not connected to the PC 

Requirements: 

• AG4soft program is loaded on the PC 

• PC and AG4 are not connected 

• The R232 serial interface must be installed on the PC. If, for example, a laptop is used with a USB-to-RS232 cable, the serial interface driver must 
first be installed. 

1. Click on the Microsoft Windows Start button in the tool bar. Click on the AG4soft icon   on the desk top.   
The software starts and a Banner AG4 start screen appears with an OK button.  

2. Click on OK. The Change authorization level dialog box opens. 
3. Select the Authorized Customer (AC) and enter the AG4soft default password: BannerA 
4. Click on OK. An automatic wizard option appears and can be used to load an existing configuration file. 

Login procedure when the AG4 is connected to the PC 

You can use the software to transfer an existing configuration from one AG4 Scanner to another.  

Requirements: 

• The AG4 is powered and connected to the PC. 

 

 

If you power the AG4 after the software start and have selected the Maintainer (Ma) or Authorized 
Customer (AC) authorization level, you must then log in to the software with the default password.  

1. Click on the AG4soft icon on the desktop.       The software starts and a Banner AG4 start screen appears with an OK button.     
 

2. Click OK.  
 The AG4 automatically contacts the connected PC. 
 The software automatically synchronizes the PC and the AG4. 
 The software automatically transfers the configuration from the AG4 and checks the data. 

 The Password and authorization level dialog box opens. 
 
3. Select the Maintainer (Ma) or the Authorized Customer (AC) and enter the AG4soft default password.  

When logging in for the first time (with a new AG4 connected to the PC), the default password for the required authorization level must be entered:  

Maintainer (Ma): BannerM 
Authorized Customer (AC): BannerA 

5. Click on OK. 

 After you’ve logged in with the Maintainer (Ma) or Authorized Customer (AC) authorization level for the first time, change the password in 
order to provide better configuration security. This new password is the specific Scanner password. The default password will no longer permit 
access for changing the configuration in this specific AG4 scanner. 

 The AG4soft program checks for communication to the connected AG4. 
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 The Scanner Status Information message appears. The status information includes administrative and safety parameter values. You can 
compare the parameters with the required parameters of the current application with this information if necessary. 

6.  Click on EXIT. The wizard can be used to modify the existing configuration or you can load a configuration from a PC file. AG4soft authorized level 
program functions can now be accessed. 

 

A default configuration file is stored in examples in the AG4 program folder (see file path below). The file 

name is standard.rs and can be used as a template that can be changed for creating new configurations.  

C:\Program Files\Banner Engineering\Banner AG\AG4soft\examples 

 

5.4 Creating AG4 configurations 

To create a new configuration or to change an existing configuration, an existing configuration must first be opened using the AG4soft program. A locally 
saved configuration file or the configuration file from the AG4 Scanner can be accessed. 

5.4.1 Load a configuration file from the AG4soft folder on the PC 

A configuration can be loaded from the PC files. If an AG4 is not connected, the load process starts after the AG4soft login. 

Requirement: 

• Logged in with the Maintainer (Ma) or Authorized Customer (AC) authorization level. 

 

1. Click the Configuration worksheet tab and click   

 The Select Safety Laser Scanner screen opens (shown on right) and presents 
 a brief summary of the AG4 attributes. 

2. Click on Exit. 

The file selection menu opens. The examples file folder opens and the standard.rs 
file and others may appear.  

3. Select a file and click Open. 

 The program loads the configuration file. A message declaring the file is now 
 loaded appears.  

4. Click on OK. 

 The configuration setting can now be modified. 

 

5.4.2 Loading a configuration from the AG4 

The configuration file from the AG4 Scanner can be loaded into the AG4soft program. 

Requirements:  

 AG4 is powered and connected to the PC.  

 AG4soft is not running 
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1. Click on the AG4soft desktop icon.   

 A message appears that declares the configuration data is being loaded from the scanner. 

 The login menu appears. 

2.  Login with Maintainer (Ma) or Authorized Customer (AC) using the default or specific password, whichever one applies. 

 A message reminding you to change the password may appear if the AG4 default password is still active. 

3.  Click on OK. 

 A message appears that declares that the program is ascertaining status information from the scanner. 

4. Click on Exit. 

 Another message appears that asks if you want to edit the configuration with the wizard. 

 If you choose Yes the wizard steps you through the editing process.  

 If you choose Exit you can use the Worksheet functions to change the configuration settings. (see section XXX on page XX) 

 

 

If you start the AG4soft program before you connect to the scanner, the serial cable should be 
connected to the PC (but not to the AG4). This cable connection allows the program to identify the correct 
communications port. 
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5.5 Change AG4 configuration parameters 

Individual configuration parameters can be changed via the function specific Worksheet tools or by using the Configuration Wizard. 

5.5.1 Change parameters with the Configuration Wizard 

The parameters of the AG4 configuration can be changed using the wizard. To edit the configuration of an AG4, connect a AG4 to the PC, and turn on the 
AG4 power, the configuration is loaded from the AG4 after the AG4soft login.  

Requirements: 

 Powered AG4 is connected to the PC 

  Logged in to AG4soft as Authorized Customer (AC). 

 The AG4 configuration will automatically load into the software program. 

 

 

Note if the AG4soft does not connect with the scanner, check your PC comm. port settings to be sure 
you are using the proper port. The AG4 connection status window should look like this: 

 

 

 The program will eventually display the Scanner status information window.  

1. Click on Exit 

 The worksheet display will show the measured surfaces and the protective and warning fields. 

2. Click on the Configuration worksheet tab and click on . 

 or, using the drop-down menu select: 

3. Configuration > Wizard.  

 The Configuration Wizard presents a series of administrative and safety operational parameter choices. 

4. Enter the values of the parameters that need to be changed in the respective fields. 

5. Click Next to go the next page. Click Back to go the previous page. 

6. Click on OK when all parameters have been entered. The configuration menu closes.  

  

7. To transfer the configuration to the AG4: Click on  in the Configuration worksheet  

 If the AG4 is connected to the PC, the configuration is transferred from the PC to the AG4. 

 Note that the new configuration is not saved to file on the PC yet.  

 Clicking on either of the Measures contour or System data worksheet tabs will cause the memory message to appear to give you the 
 option, and remind you, to save a copy to file.  

 More detail on the PC to AG4 configuration transfer and confirmation process is discussed in section 5.8.1 
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5.5.2 Change individual parameters 

The parameters of the AG4 configuration can be changed using the Configuration parameters menu below. Administrative and safety-relevant 
parameters are combined in folders with the same name. Protective and warning fields that belong together are combined in the folders as Field pair 1 to 
Field pair 7 respectively. 

1 2 3

 

1 Folder selection 
2 Parameter selection 
3 Change single value parameters in input area (inactive) 

Figure 4 Configuration Parameters Main Menu 

 

Parameters shown as R in the Status column are “read only” and cannot be changed. 

 

Requirements: 

• Logged in as Authorized Customer (AC). 

• Load a configuration in the software program. 

1. Click the Configuration worksheet tab and Click on  or, using the drop-down menu, select: Configuration > Change.  

The Configuration parameters menu opens.  

2. Click on the folder that contains the parameters that require modifying.  

The program now displays the folder's parameters in the parameter selection field. 

3. Double-click on the parameter that is to be changed. 
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If a single value parameter has been selected, a sub-menu opens to the right of the status field. The current selection is shown and an entry field for 
the new selection is provided. 

 
Figure 5   Configuration Parameters Menu 

4. Select New Value for parameter as required then click Accept. 

5. To print the configuration, in this menu click Print. 

6. To save the configuration in the *.txt format click Create text file. 

If a multi value parameter has been selected, a pop-up menu opens, showing the current values. 
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7. Select the appropriate fields as necessary and when complete, click OK. 

8. When all required parameters have been changed confirm with OK in the configuration main menu. 

 The changed configuration can now be downloaded to the AG4 or saved in a file. 

If the operating mode is changed before the changed configuration has been downloaded or saved, the Memory message appears: 

 

9. Ensure that the appropriate checkboxes are checked and confirm with OK.  

  The program executes the selected functions, or 

10.  To discard all changes to the configuration, click on the Discard button,  

  the program reverts to the previous configuration, or 

11.  To edit the configuration, click on Cancel. 
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5.6 Save an AG4 configuration 

To save the changed configuration, the configuration file can be downloaded to the AG4 or saved in a file on the PC.  

 

The configuration settings can be printed or saved as a text file in the *.txt format 

 

5.6.1 Transfer configuration data from PC to AG4 

In order that the changes to the configuration become active in the scanner, the changed configuration file must be transferred to the AG4. 

Requirements: 

 PC and AG4 are connected. 

 Logged in with Maintainer (Ma) or Authorized Customer (AC) authorization level. 

 Changed configuration file is loaded in the program. 

1. Click on the Configuration worksheet tab and click on . 

 or, using the drop down menu select: 

2. Configuration > Transfer from PC to scanner.  

 The program checks the configuration file and downloads it to the AG4. 

 If only administrative parameters have been changed, the AG4 does not send any echo (confirmation) data. However, if safety-relevant 
 parameters have been changed, the AG4 sends echo data to the PC. 

The Scanner echo data message appears:  

 

3. Check the echo data and confirm that it is correct then click Accept. 
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The Scanner protective field echo data menu opens for each protective field (see image below). 

 

 
 

 

4. Check the protective field echo data for all protective fields. 

5. If the protective field echo data is correct, click Accept.  

 The next field echo data appears until all protective fields have been confirmed. 

 At the end of this process, the software checks the configuration file and transfers it to the AG4 again. 

 The Configuration data transfer from PC to Scanner message opens. 

6.     Click OK. The software saves the configuration file in the AG4 and now uses it as its active operating configuration. 

5.6.2 Save configuration data as a file 

The loaded configuration can be saved in a folder on the PC. 

Requirements: 

 Logged in with the Authorized Customer (AC) authorization level. 

 The changed configuration file is loaded in the software. 

 

 

Select the Save configuration data as a file function if, for example, an AG4 is not connected 
with the PC. A configuration saved on the PC can be transferred as a file later to the AG4. 

1. Click on the Configuration worksheet tab and Click on  or, using the 

drop-down menu select : File > Save configuration data as a file 

 The AG4 example file folder opens. 

2. Name the file and click on Save. The software saves the configuration file in 

the *.rs format. 
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5.7 Create and edit protective/warning field configuration 

To create a new protective/warning field configuration, load an existing protective/warning field configuration and change its field boundaries and save as 
a new file. 

 

 

An AG4 configuration must be loaded into the software so that changes can be made to 
protective or warning fields. The data of an individual protective or warning field configuration 
can be saved as its own file. When the AG4's configuration file is saved, the protective or 
warning field file is automatically included in the AG4's configuration file. 

 

5.7.1 Load protective/warning field configuration 

To create or edit a protective or warning field configuration, load an existing protective/warning field configuration into the AG4soft program. 

Requirements: 

 Logged in with the Authorized Customer (AC) authorization level. 

 A configuration file is loaded in the software. 

1. Click on the Protective/warning fields definition worksheet tab and click . 

 or, using the drop down menu select: 

2. File > Load protective/warning field from a file. 

 The AG4 examples folder opens. 

3. Select the file that you want and click Open. 

 

The protective and warning fields appear in the 
 AG4soft worksheet display area. 

 
 
 
 
 
 
 
 NOTE: Individual protective or warning field configurations can be loaded from a file. If an AG4 configuration is already loaded, all defined 
protective/warning fields in it are automatically loaded. 
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5.7.2    Edit protective and warning fields 

Once the file is open in the AG4 soft program, the protective and warning fields boundaries and the reference surfaces can be changed.  

Select protective or warning field 

To edit a protective or warning field, a field to be displayed in the work space must be selected. 

To select a field: 
1. Click on the Protective/warning fields definition worksheet tab and use the drop 

down field menu (see image on right), to select the protective of warning field that 
you want to change. 

 or, using the drop-down menu, select: 

2. Protective/warning fields > Select protective/warning field 

Use the Protective/warning field selection menu that appears (see image 
right) , to select the protective of warning field that you want to change. 

 
 
The software displays the protective (red) and warning field (green) boundaries as red and green respectively. The colors represent the field 
boundaries of field pair 1. Although both fields of the 1st field pair are shown in color in the work space below, only the protective field is “active”, that is, 

only the protective field can be changed with the editing tools in the worksheet. Other field pair boundaries can be displayed and will appear in light gray if 
the field pair is selected (see Selected field pairs window in the image below). 
 

The active field that can be changed 

The Field pairs displayed
 

 
  
Figure 6. Protective and warning fields displayed 
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The drop-down menu in the Protective/warning field worksheet tab below shows that Protective field 1 is active.  
The selected pairs that are being displayed are field pair 1 (red & green) and field pair 3 (grey rectangles). See Select field pair window in the lower left corner of Figure 6. 
 

Select field pair to be displayed  
To set which field pairs are displayed in the work space, in the drop down menus area select: 

1. Settings,  then select 
2.  Displayed field pair selection and 
3. Check the pairs to be displayed (see image at right) 
4. Click on OK. 

 
 
The work space will show only those field pair selections in the work space 

 

5.7.2 Defining protective and warning fields 

Protective and warning field boundaries can be defined by entering numeric values or by using the graphic editing tools.  

 NOTE: The field boundary tools  can be accessed in the Protective/ warning fields worksheet or via the drop-down menu. 

5.7.2.1 Numerical Changes 

Requirements: 

 Logged in with the Authorized Customer (AC) authorization level. 

 The changed configuration file is loaded in the program. 

 The protective or warning field is selected. 

1. Click on the Protective/warning fields definition worksheet tab and click on  

 or, using the drop down menu select: 

2. Protective/warning fields > Define protective/warning field> Protective/warning field numerically. 

 
 

The Define protective/warning field menu appears. 
 

3. Enter the values for the front, left and right edge in mm and click OK. 

 

 

 

 

 

A caution message for angle resolution will open and 
recommend a slight value adjustment. To accept the 
recommended values,  

4. Click Yes. 
 

 
The window closes and the redefined field boundaries are displayed in the worksheet. 
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5.7.2.2 Graphical Changes 

A selected protective or warning field can be defined as an ellipse, a rectangle or a polygon.  

When a graphic field change tool selected, the mouse pointer   changes to a hand with pointed index finger and is used as a tool to define the field 
boundary limits. 

If the ellipse or rectangle field tool is selected,    the field boundaries are created by pressing the left mouse button while moving the hand across 
the work space. The cursor position corresponds with the outer-most point on the ellipse or the rectangle. The field changes dynamically as the pointer is 
moved within the worksheet display.  

Requirements: 

 Logged in with the Authorized Customer (AC) authorization level. 

 The configuration file is loaded in the software. 

 The protective or warning field is selected. 

5.7.3 Elliptic Field 

1.   Click on the Protective/warning fields worksheet tab and click on , the elliptical field tool. 

 or, using the drop down menu select: 

2.   Protective/warning fields > Define > elliptical zone. The cursor changes to a hand with pointed index finger. 

3.    To designate the boundaries of the ellipse: Position the cursor near the area in the work space where you want to place the field.  

4.    Press and hold the left mouse button (a preview of the elliptical boundary appears) and move the cursor until the proper field size is established. 

5. Release the button to set the field in the work space. A thin line displays as a preview of the elliptical zone, in addition to the existing zone. 

 

Figure 6.   Elliptical Protective field 1  NOTE: During the field change operation, the X and Y values of the cursor position in the navigation area 
define the maximum area boundary dimensions of the short and long axes of the ellipse. 
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Correcting a field 

 If you want to change the field shape repeat the process again.  

 The old field boundary will be replaced with the new field boundary. 

 

If you accidentally click on the wrong tool button you can start over by pressing the Esc key on your PC. 

5.7.4 Rectangular field 

 Click in the Protective/warning fields definition and Click . 

 or, using the drop down menu select: 

 Select Protective/warning fields > Define > rectangular zone. The cursor changes to a hand with pointed index finger. 

To designate the boundaries of the rectangle: 

1. Position the cursor near the area in the work space where you want to place the field.  

2. Press and hold the left mouse button (a preview of the rectangular boundary appears) and move the cursor until the proper field size is 
established. 

3. Release the button to set the field in the work space. 

The work space below shows a thin line preview of the rectangular field (no other field is shown). 
 

 

Figure 7.  Rectangular Protective field 1 

NOTE: In the figure above, during the field change operation, the X and Y values of the cursor position in the navigation area define the maximum area 
boundary dimensions of the short and long axes of the ellipse. 
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Correcting a field 

 If you want to change the field shape, repeat the process.  

 The old field boundary will be replaced with the new field boundary. 

5.7.5 Polygon Field 

The order in which the corner points of the polygon are set depends on the workspace display: 

 If the AG4 is displayed below in the workspace, set the boundary corner points from left to right. 

 If the AG4 is displayed above in the workspace, set the boundary corner points from right to left. 

1. Click on the Protective/warning fields definition worksheet tab and click . 

 or, using the drop down menu select: 

2. Protective/warning fields > Define > polygonal zone. 

 The cursor changes to a hand with pointed index finger. 

3. To define the first corner point of the polygon, position the cursor at that point on the work space and click the left mouse button 

4. Left click the remaining points of the required polygon area. 

 The software shows a thin line as a preview of the polygon section. 

 

Figure 8.  Polygon field shape. The figure above shows the first 3 sides of the polygon shaped protective field. 

NOTE: In the figure above, during the field change operation, the X and Y values of the cursor End position display in the navigation area define the 
corner boundary points of the polygon field. 
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5. When the polygon shape is complete, Right-click to establish and display the polygon area (see complete polygon field below).  

   . 

NOTE: When you complete the polygon shape, the software connects the end points and accepts the field boundaries. 

Correcting a field 

 If you want to change the field shape repeat the process with the new shape.  

 The old field boundary will be replaced with the new field boundary. 

 
Change protective and warning fields 

A protective or warning field shape can be modified if needed.  

Requirements: 

 Logged in with the Authorized Customer (AC) authorization level. 

 The configuration file is loaded in the program. 

 The protective or warning field to be modified is selected. 
Change a field shape 

This function allows the user to modify or reshape the boundaries of a field by sections (see figure XX below). 

The warning field shape below can be modified e.g. to create an unmonitored space for a passage way between the warning field (yellow line) and the 
wall (green line). The program connects the two points with a straight line generates a new field boundary. 

 
Figure 9.  Elliptic warning field that projects into a wall (green line) and material access route (not visible) 
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Requirements: 

• Logged in as Authorized Customer (AC). 

• The configuration file is loaded in the software. 

• The warning field is selected. 

 Click the Protective/warning fields definition worksheet tab and click  . 

 or, using the drop down menu select: 

 Select Protective/warning fields > Change protective/warning field segment. 

 The cursor changes to a hand with pointed index finger. 
 The program displays the selected field boundary in bold. 

 

 

1. Position the cursor at the 1st point on the work space. 

 (see work space right for example) 

2. Press and hold the left mouse button. 

3. Release the button when the cursor is positioned properly 

A guide line from the AG4 to this 1st point appears. 

4. Position the cursor at the 2nd point on the work space. 

5. Press and hold the left mouse button. 

 

 

 

 

 

 

6. Release the button when the cursor is positioned properly 

7. Right click to establish the new field shape. 

 A line connects the points (see work space right for example) 
 and the new boundary is established. 
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Set as many coordinate points as needed to shape the field. 

 (see work space right for example) 
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5.7.6 Change all fields 

It is possible to change all of the AG4 protective fields or warning fields at the same time.  

1. Click the Protective/warning fields definition worksheet tab and click  . 

 or, using the drop down menu, select: 

2. Protective/warning fields > Change protective/warning field segment with all fields. 

 A confirmation message appears (right) 
 

3. Click Yes to continue or No to reject. 

4. Change the field shape as described in Change a field 
shape, above. 

 NOTE: When the changes have been completed, all of the protective fields (as a group) and/or all of the warning 
fields (as a group) will have had their boundaries changed in a similar manner though they will not necessarily 
have the identical shape. 

 

 

Changing all protective fields or all warning fields with the Change protective/warning field segment with all 
fields tool will produce identical field shapes or boundaries only if the field shapes are identical when you start 
the field change process. 

5.7.7 Reduce field limits 

The field limits of a protective or warning field can be reduced by establishing numerical values for the limits. 

Requirements: 

 Logged in with the Authorized Customer (AC) authorization level. 

 The changed configuration file is loaded in the software. 

 The protective or warning field is selected. 

1. Click the Protective/warning fields definition worksheet tab and click.  

  or, using the drop down menu select: 

2. Protective/warning fields > Reduce protective/warning field limit 

  The Reduce protective/warning field limits menu appears (right). 

3. Enter new values for the front, left or right edge in mm and click OK 

 A message for angle resolution opens to recommend a value adjustment.  

4.  To accept the recommended values, click Yes. 

The window closes and the redefined field boundaries are displayed in the worksheet. 
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5.7.8 Blank out segments 

Individual field segments can be blanked out or not monitored, by establishing two points on either a protective or a warning field boundary. The program 
creates the unmonitored region between the points. The unmonitored region boundaries extend along a radial line to the AG4 

1. Click the Protective/warning fields definition worksheet tab and click . 

or, using the drop down menu select: 

2. Protective/warning fields > Blank out 
protective/warning field segment. 

The pointed index finger cursor appears. 

3. Click on the 1st point on the field  

 (see work space right for example 

 

 

 

 

 

 

 

 

 

4. Click on the 2nd point on the work space 

 

 

 

 

 

 

 

5. Right click 

 

 

 The new field shape appears with the unmonitored section 
 clearly visible in the workspace. 

 
 
 
 
 
 
 
 



Banner AG4soft Software Instruction Manual  
 

Software Manual  144923 05/2009 35 

 

5.8 Set the reference contour  

A reference contour or surface in a protective field can be created by establishing two points on the field boundary. The software program establishes this 
surface along the field boundary line between the two points. You cannot set a reference contour in a warning field. The reference can be a surface on a 
machine or within an work area. The surface must be stationary with respect to the AG4 and must be within the protective field range for the application.  

If the Passage control (3.5 meter range), Arm protection (2.25 meter range) or Hand protection (1.5 meter range) application is selected in the 
configuration, the software automatically defines the entire protective field limit as reference contour. You can reset parts of the reference contour 
retroactively.  

 

1 Reference contour 
2 Transition area between protective field contour and reference contour 
3 AG4 

Figure 10. Set reference contour 

Requirements: 

 AG4 powered and connected to the PC 

 Logged in with the Authorized Customer (AC) authorization level. 

 A configuration file is loaded in the software. 

 The protective or warning field is selected. 

 A segment in a protective field is defined. 
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When setting the reference surface, ensure smooth transitions between protective field with reference contour and 
protective field segments without reference contour. The reference contour must lie on the measured contour; the 
protective field limit slightly before the measured contour. 

1. Click the Protective/warning fields definition worksheet tab and Click . 

or, using the drop down menu select: 

2. Protective/warning fields > Define protective segment as reference contour 

In the work space,  

3. Click a point on the protective field boundary. 

4. Click another point on the protective field boundary. 

5. When the button is released, the reference is established. 

The software shows a blue connection line from the starting point to the end 
point of the reference contour. 
 

If it is necessary to create a reference contour that consists of several 
sections, repeat the process until the contour corresponds with the desired 
display. 

 

If it is necessary to delete a reference contour,  

1. Click the Protective/warning fields definition worksheet tab and click  

or, using the drop down menu select: 

2. Protective/warning fields > Reset reference contour definition for protective field 
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5.9 Saving protective/warning fields 

Protective and warning fields can be saved as follows: 

• When a AG4 configuration is saved, the software automatically saves all loaded protective and warning fields in the configuration file 

• The selected protective or warning field can be saved individually in a protective/warning field configuration file. 

• One or more of the displayed protective or warning fields can be downloaded together from the PC to the AG4 and saved there. 

5.9.1 Save as a file 

When protective or warning field changes have been made they can be saved on the PC for record keeping purposes or for later use.. 

 

If the AG4 is not connected with the PC, the changed protective/warning field configuration can be saved on the 
PC as a file, then downloaded to the AG4 at another time. For complicated field boundaries or for fields that 
supplement one another in switchover mode, a saved protective/warning field configuration can be transferred to 
another field pair. 

 

Requirements: 

 Logged in with the Authorized Customer (AC) authorization level. 

 The protective or warning field is loaded in the program and selected. 

1. Click the Protective/warning fields definition worksheet tab and click . 

  or, using the drop down menu, select: 

2. File > Save protective/warning field as a file. The AG4 examples folder opens. 

3. Name the file and click Save. 

The software saves the protective/warning field configuration file in the *.rs format. 

5.9.2 Transfer protective and warning field configurations from the PC to the AG4 

One or more of the scanner’s protective or warning fields configurations can be changed and transferred to the AG4 so that these new field configurations 
can become active in the scanner. 

Requirements: 

 The AG4 is powered and connected to the PC 

 Logged in with the Authorized Customer (AC) authorization level 

 The protective or warning fields from the Scanner are loaded in the 
software 

 The field changes have been made 

1. Click the Protective/warning fields definition worksheet tab and click  

 or, using the drop down menu, select: 

2. Protective/warning fields > Transfer changed protective/warning fields from 
PC to scanner. 

 A message appears (example shown at right) that lists all the changed fields 
that can be transferred to the Scanner. Deselect (uncheck) the box for any 
field that you do not want to transfer to the Scanner, and  

3. Click on Transfer. 
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The program sends to new field parameters to the AG4. A copy of the echo data for each change field is defined in the program for review. If field 
data are correct, 

4. Click on Accept. 

The program establishes and activates the new fields in Scanner and the Transfer protective/warning data from PC to Scanner message 
opens. 

 

5. To confirm the message, click on OK. 

The software saves and activates the changed protective and warning field files in the AG4.  
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6 Documentation, Passwords, Maintenance 
 

6.1 Configuration Documents 

The following AG4 status and configuration information can be printed: 

 Status information  

 AG4 configuration  

 Protective/warning field configuration  

 Diagram  

 

If a printer is not connected the information can be saved as a file in the *.txt format. 

 

6.1.1 Print status information 

The AG4's status information can be printed or saved as a text file and includes: 

 Administrative parameters, e.g., name, serial number 

 Safety-relevant parameters, e.g., protective field additional distance values, startup process 

 Permitted field pair switchovers 

 Date a zone was last saved 

 Output resolution 

Requirements: 

 The program is connected with the AG4 

 The status information from the AG4 is loaded 

1. Click the System data worksheet tab and click . 

  or, using the drop down menu, select: 

2. System data > Transfer status information from Scanner to PC 

 The Scanner status information dialog appears. 

3. Click Print to select a printer. 

4. Click on Create text file to create a text file. 
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6.1.2 Print AG4 configuration 

The AG4's configuration can be printed or saved as a text file. 

The printout and the text file includes the following information: 

 Print date 

 User 

 Data source 

 Administrative parameters 

 Safety-relevant parameters 
 Name of all field pairs and date they were saved 

Requirements: 

 The program is connected with the AG4 

 You have loaded the status information from the AG4 
Printing 

1. Click the Configuration worksheet tab Click on . 

 or, using the drop down menu, select: 

2. Configuration > Print. 

6.1.3 Create text file 

1. Click the Configuration worksheet tab and click . 

  or, using the drop down menu, select: 

2. Configuration > Change 

 The Configuration parameters dialog box opens. 

3. Click on Create text file. 

6.1.4 Print protective/warning field configuration 

A protective/warning field configuration can be printed and include 

 Name and description of the zone 

 Date the zone was last saved 

 Permitted field pair switchovers 

 Minimum object width 

 Print date 

 User 

 Data source 

 Serial number 

 AG4 name 

 Graphic display of the zone 

 Maximum values 

 Blanked out segments 
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Requirements: 

 The software is connected with the AG4 

 A AG4 configuration is loaded in the software 

1. Click the Protective/warning fields definition worksheet tab and click . 

 or, using the drop down menu, select: 

2. Select Protective/warning fields > Print 

 The Print protective/warning fields dialog opens. 

 The protective/warning field and optimized display can be selected.  

3. Click on Print. 

6.1.5 Print work space diagrams 

Work space diagrams (measured surfaces, protective and warning fields) may be saved as bitmap files in the *.bmp format and then printed. 

Requirements: 

 The program is connected to the AG4 

 A AG4 configuration is loaded in the software 

1. Select View > Save diagram as a file. 

2. Locate file in AG4 software program (C:\Program Files\Banner Engineering\Banner AG\AG4soft\examples) and open the appropriate bitmap 
program to view or print. 
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6.2 Calibrate front screen 

 
 

CAUTION . . . FAULTY CALIBRATION CAUSED BY DIRTY OR SCRATCHED FRONT SCREEN 

 

 Only calibrate front screens that are clean and free of scratches, cracks, abrasions or other marks that could impair 
pulsed light signal transmission. 

 Clean the front screen with the Cleaning Set (AG4-CLN1 or AG4-CLN2)  
 

If the AG4's front screen has been replaced for any reason, the AG4 must be re-calibrated. If not, the correct safety functioning of the AG4 can no longer 
be guaranteed. 

Requirements: 

 The AG4's front screen is replaced 

 The AG4 is connected with the PC 

 The ambient temperature is between 20 and 25°C 

 Logged in with the Authorized Customer (AC) authorization level 

1. Click the System data worksheet tab and click . 

 or, using the drop down menu, select: 

2. Select System data > Calibrate the front screen. 

 The Calibrate the front screen dialog opens: 

3. Enter the password FS8LED and click Calibration.  

 The software starts the calibration process and 
 shows the calculated values of the front screen 
 measured distances and the reference distances in 
 the dialog. 
 

4. Click Exit to close the dialog. 

The AG4 is now re-calibrated with the new front screen. 
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6.3 Change password 

The password with which users of the Maintainer (Ma) or Authorized Customer (AC) authorization levels log in on the AG4 can be changed.  

Examples: 

• With the first login of the AG4, users of the authorization levels Maintainer (Ma) or Authorized Customer (AC) use the Default password. The 
Default password must be changed to a Specific password. 

• A user of the Maintainer (Ma) authorization level has forgotten the password or entered it wrong several times 

 

A password must be at least six and a maximum of eight characters long. Combinations of 
letters and numbers may be used as well as both lower and uppercases. 

 

Requirements: 

• Logged in with the Authorized Customer (AC) authorization level 

• The software is connected with the AG4 

1. Select Security > Change password. 

 The Change password dialog opens. In the Password selection list; 

2. Select the authorization level for which you want to change the default password. 

3. Enter the new password in the New password 

4. Enter the password again in the Repeat password field 

5. Click OK. The software transfers the new password to the AG4 where it is then saved. 

6.4 Reset password 

If a user at the Authorized Customer (AC) authorization level has forgotten their specific password or entered it incorrectly several times, they cannot log in 

on the AG4. The Change password function is therefore not accessible. 

Instead, the specific password must be reset. The Reset password function is available for users of the Operator (Op) authorization level and requires a 
password to access. During a telephone call with the Applications department a one-time password can be created, which the manufacturer confirms and 
the customer subsequently uses in order to create a new specific password 

To reset your specific password, compile the information listed below and contact Banner Engineering. Provide the following information: 

 Your company address 
 Your company contact person’s name 
 A telephone number where they can be reached 
 The AG4 serial number (below the bar code on the label on the side of the AG4) 

How to Contact Banner Engineering 
To contact the Safety Application Engineering, call Banner’s North American headquarters at: 

 763-544-3164  
 1-888-373-6767 (toll free) 
 Banner Engineering Corp., 9714 Tenth Ave. North, Minneapolis, MN 55441. 
 
Or you can also send the information via email to: sensors@bannerengineering.com 

Or you could contact your local Banner sales partner and provide them with the information above.  

Either way, one of the Safety Applications Engineers will contact you and take you through the following steps. 
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6.5 Create a one-time password 

Requirements: 

 Logged in with the Operator (Op) authorization level. 

 The program is connected with the AG4. 

 
1. Select Security > Reset password.  

 The Set new password with one-time password dialog opens. 

2. On the Create one-time password tab select Create. 

  The software loads the one-time password from the AG4 and shows it in red. 

  When the Banner Engineering Safety applications engineer has the one-time password, they will create a new password. 

3. Select the Set new password tab, 

4. Enter the one-time password in the Confirmed password field, 

5. Enter the new password in the New password field,  

6. Repeat the entry in the Repeat password field, 

7. Click OK 

The program communicates with the connected AG4 and saves the new password for the Authorized Customer (AC) authorization level in the AG4. 

The new password is effective after a restart of the software. 

6.6 Create diagnostics list and service file 

6.6.1 Create diagnostics list 

The AG4 will generate a diagnostic list that can be used to identify operation problems and remedies (refer to the AG4 Product Manual for information on 
diagnostics and remedial steps). 

The diagnostics list contains the following information: 

 AG4 serial number 

 Firmware version 

 Date the diagnostics list was created 

 List of the last eight incidents that occurred with place, number and parameters 

Requirement: 

 The PC is connected to a powered AG4 with the AG4soft program running 

1. Click the System data worksheet tab and Click  

 or, using the drop down menu, select: 

2. System data > Display the Scanner diagnostics list 

The Diagnostics list dialog box opens. 

3. Click Re-load to update the diagnostics list. 

4. Click Print to print the diagnostics list. 

5. Click Save to save the diagnostics list in the *.txt format. 
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6.6.2 Create service file 

A service file contains the configuration, diagnostics and system data of a connected AG4 and can be created in the *.sdc format. 

This file can be sent to sensors@bannerengineering.com in cases where diagnose information is needed to solve an application or operation problem.  

Requirement: 

 The PC is connected to a powered AG4 with the AG4soft program running 

1.  Click the System data worksheet tab and click . 

 or, using the drop down menu, select: 

2.  System data > Create service file 

 A dialog box for saving the service file opens. 

3.  Name the file and click Save. 

 The program saves the service file in the *.sf format. 

4.  Send an e-mail with the service file attached to sensors@bannerengineering.com with the following information:  

 Company address 
 Company contact person’s name 
 Contact person’s telephone number 
 AG4 serial number below the bar code on the label that’s on the side of the AG4) 
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7 Menu item reference 
An overviews of the AG4soft program menu items, icon functions and tools can be found in this chapter. 

7.1 Menu 

The Menu chapter gives an overview of all menus and menu items. 

 

Please note that the available menu items depend on both the selected authorization level and the selected 

operating mode. If, for example, the AG4 is to be configured, first an Authorized Customer (AC) level log in is 

needed and secondly, the AG4soft program must be in Configuration mode. 

 

7.1.1 File 

Table 6.  Menu items in the File menu 

Menu item Function 

Load protective/warning field from a file Opens a single protective or warning field configuration file  

Save protective/warning field as a file Saves a selected protective or warning field configuration as a file. 

Load configuration data from file Opens an AG4 configuration file. 

Save configuration data as a file Saves the loaded AG4 configuration as a file. 

Exit configuration program Exits the software. 

 

7.1.2 View 

Table 7.   Menu items in the View menu 

Menu item Function 

Zoom Reduces the work space and the displayed diagram in steps. 

Unzoom Enlarges the work space and the displayed diagram in steps. 

Show all Enlarges the work space and the displayed diagram to full size of 70 x 70 meters. 

Save diagram as a file Saves the displayed diagram as a bitmap file in the *.bmp format. 
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7.1.3 Settings 

Table 8.   Menu items in the Settings menu 

Menu item Submenu Function 

Measured contour display Changes to the Measured contour display operating mode. 

Configuration Changes to the Configuration operating mode. 

Protective/warning fields definition 
Changes to the Protective/warning fields definition operating 
mode. 

Operating mode 

System data Changes to the System data operating mode. 

Interface 
Opens a dialog box in which you select the serial interface and the 
transfer rate. 

Languages 
Opens a dialog box in which you select the language of the interface 
texts. 

Change diagram color 
Changes the color of the work space from black to white to optimize it 
for printouts. 

Rotate contour display by 180° 
Rotates the contour display in the work space to adjust the display to 
the AG4's mounting situation. 

PC configuration 

190° protective/warning fields 
Extends the display of the protective/warning fields for the definition 
by 10°. This setting does not change the measured value recording.  

Field pair display 
Opens a dialog box in which you select the field pairs that are to be 
displayed on the work space. 

Activities list 

Opens a message that displays all communication processes 
performed since the software was last started. 
With the MotionMonitoring function, the activities list shows the 
individual actions and provides the status of the speed monitoring. 
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7.1.4 Configuration 

Table 9.  Menu items in the Configuration menu 

Menu item Function 

Wizard Opens the configuration wizard with which you change the configuration parameters. 

Change Opens a dialog in which you change individual parameters. 

Set default values in the scanner Sets the AG4's configuration back to the default status. 

Printing Prints the configuration file. 

Load from file and transfer to scanner Opens an existing configuration file and transfers the data to the AG4. 

Get from scanner Loads the configuration file from the AG4 into the software. 

Transfer from PC to scanner Transfers the configuration file to the AG4. 

7.1.5 Protective fields /warning fields 

Table 10.  Menu items in the Protective/warning fields menu 

Menu item Submenu Function 

Protective/warning field selection 
Opens a dialog box in which you select the displayed protective/warning 
field. 

Changed protective/warning fields 
Opens a dialog box in which all protective/warning fields that were changed 
since the last save are marked. 

Numerical field entry 
Opens a dialog box in which you define the edges of a selected 
protective/warning field. 

Elliptical zone 
Enables an elliptical protective/warning field to be defined on the work 
space. 

Rectangular zone 
Enables a rectangular protective/warning field to be defined on the work 
space. 

Define 

Polygon zone 
Enables a polygonal protective/warning field to be defined on the work 
space. 

Change Change protective/warning field 
segment 

Enables a segment to be changed in the selected protective/warning field. 
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Change protective/warning field 
segment for all field 

Enables a segment of all protective or all warning field boundaries to be 
changed at the same time. 

Reduce zone limits 
Opens a dialog box in which you reduce the zone limits of the selected 
protective/warning field. 

 

Blank out segments 
Enables a segment to be blanked out in the selected protective/warning field 
contour.  

Set 
Enables a reference contour to be defined in the selected protective field 
contour. 

Reference contour 

Reset 
Enables a reference contour to be highlighted in the selected protective field 
contour. 

Delete  Deletes the selected protective or warning field. 

Printing  
Prints the graphic display and some parameters of the selected 
protective/warning field. 

Transfer from PC to scanner  
Transfers one or more selected protective/warning field configurations to the 
AG4. 

 

7.1.6 System data 

Table 11.  Menu items in the System data menu 

Menu item Function 

Load status information from the AG4 Transfers the status information from the AG4 to the software. 

Display the scanner's diagnostics list Loads an incident list from the AG4 and opens the list in a dialog box. 

Create service file Opens a dialog box to save the service file in the *.sdc format. 

Calibrate the front screen Opens a dialog in which you calibrate a new front screen. 

Reset scanner 
Resets the safety-related switching outputs on the AG4 (Reset), required, for example, 
after cleaning. 
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7.1.7 Security 

Table 12.  Menu items in the Security menu 

Menu item Function 

Change authorization level Opens a dialog box in which you can log in with another authorization level. 

Change password 
Opens a dialog box in which you enter a new password for the selected authorization 
level for the login on the AG4. 

Reset password 
Opens a dialog box in which you enter a new password for the Authorized Customer 
(AC) authorization level for the login on the AG4.  

Need to contact Banner for access to this function. 

 

7.1.8 Help 

Table 13.  Menu items in the Help menu 

Menu item Function 

AG4 Product Manual Opens the AG4's Product manual as a PDF file. 

AG4soft Manual Opens the AG4soft configuration and diagnostics software manual as a PDF. 

AG4 Applications information Opens copy of the AG4 reference material 

AG4 System Checkout summary Opens copy of the AG4 Checkout procedures 

 

7.2 Interface Button Functions 

The AG4soft interface has worksheet toolbars to display buttons for various functions summarized in the tables below. 

7.2.1 Common Worksheet Buttons  

Table 14.  List of buttons and associated functions 

Icon Button/Function Comment 

 Zoom Reduces the work space and the displayed diagram in steps. 

 Unzoom Enlarges the work space and the displayed diagram in steps. 

 Show all Enlarges the work space and the displayed diagram to full size of 70 x 70 meters. 

 Change authorization level 
Opens the Change authorization level dialog box. You can log in with another 
authorization level. 

 Exit configuration program Exits the software. 

 

50 144923 05/2009 Software Manual 

 



Banner AG4soft Software Instruction Manual  
 

Software Manual  144923 05/2009 51 

 

7.2.2 Measured contour display buttons 

Table 15.  Measured contour display buttons 

Icon Button/Function Comment 

 Displayed field pairs selection Permits field pair boundaries to appear in the workspace 

 

 

7.2.3   Configuration buttons 

Table 16.  Configuration buttons 

Icon Button/Function Comment 

 Load configuration data from file Accesses the AG4 folder for configuration file review or changes 

 Save configuration data as a file Save a configuration file in the folder 

 Print configuration data Prints data 

 Load configuration data from a file and transfer to scanner Opens configuration file and sends it to the AG4 

 Retrieves configuration data from scanner  

 Transfer configuration data from PC to scanner 
Sends a configuration to the AG4 for use as the active operational 
settings 

 Change configuration data with the wizard Step by step process for beginners 

 Change configuration data 
Accesses a table of parameters that summarizes a configuration. 
Some parameters can be changed with the use of this function. 

 Set default configuration values in the scanner A read only file used as a template to start a new configuration.  
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7.2.3 Protective/warning fields definition buttons 

The following buttons are used for specific functions in the Protective/warning fields definition worksheet. 

Table 17.   Protective/warning fields definition buttons 

Icon Button Function 

 
Displayed field pairs selection  

 
Load protective/warning field from a file  

 
Save protective/warning field as a file  

 
Print protective/warning field  

No image Select protective/warning field  
A drop down field selection window in the Protective/warning field 
worksheet. Used to enable the field that in the workspace for editing purposes. 

 Enter protective/warning field numerically For setting field boundary limits numerically. 

 
Define elliptical protective/warning field For setting an elliptical field boundary shape. 

 
Define rectangular protective/warning field For setting a rectangular field boundary shape. 

 
Define polygonal protective/warning field For setting a polygon field boundary shape. 

 Change protective/warning segment For editing an existing field boundary. 

 
Change protective/warning segment with 
all fields 

For editing all existing field boundaries at the same time. 

 Reduce protective/warning field limits For reducing an existing field boundary. 

 Blank out protective/warning field segment For creating an unmonitored zone within an existing field boundary. 

 
Define protective field segment as 
reference contour 

For creating a reference segment within a field boundary. Used when the 
application requires a monitored reference surface for greater safety integrity. 

 
Reset reference contour definition for 
protective field segment 

For resetting the reference surface limits 

 
Delete protective/warning field For eliminating the reference surface limits 

 
Transfer changed protective/warning fields 
from PC to scanner 

For transferring only the protective/warning field information to the AG4. 
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7.2.4 System data buttons 

The following buttons are used for specific functions in the Protective/warning fields definition worksheet. 

Table 18.  System data buttons 

Icon Button Function 

 Transfer status information from Scanner to PC For reviewing the operations settings of the AG4 

 Display the scanner's diagnostics list Displays information needed for trouble shooting and remedial actions 

 Create service file  

 Calibrate the front screen Used after cleaning or replacing the screen (window) 

 Reset scanner Returns the AG4 to its factory configuration settings 
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